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7. SharePoint Server 2010

Getting Started

The SharePoint Server Window

O o N

©® Browser Tabs and Toolbars — allow the user to navigate in
the browser.

® Site Actions Button — contains shortcuts to create and edit
items.

© Page Title Links — are breadcrumb links that allow you to
quickly navigate through pages.

® Link Bar — contains shortcuts for common actions and
features.

® Quick Launch Bar — contains shortcuts to common content
areas of the SharePoint site.

@ Site Settings Button — contains shortcuts to profile and
setting options. '

@ Tab Bar — contains tabs that display tools and commands in
the ribbon.

® Search — allows the user to search the site for information.

® Web Part — contains content information. Web parts are the
containers of information that make up the site.

Note: SharePoint Server is a highly customizable application;

your views and features may be different and you may not have

permission to perform all tasks highlighted in this guide. The

Home page is displayed above.

Navigating in SharePoint
There are several ways to navigate through sites and pages in
SharePoint Server 2010.

o Link Bar — click a shortcut on the Link bar to go directly to a
specific site. Click the Home shortcut to return to the home
page for that site.

e Page Title Links — click on the Browse tab to display
breadcrumb navigation for the pages within a site. Click a page
name to go directly to that page.

o Navigate Up button — click the
Navigate Up button on the

Tab bar to display breadcrumb b MAIN
navigation for the site in a Ly Shared Documents

hierarchical view. Click a shortcut S
to go directly to that page.

This page location is;

T

Using the Quick Launch Bar
By default, the following content areas are located on the Quick
Launch bar:
¢ Libraries — contain groups of shared files. The default libraries
are Site Pages and Shared Documents.
e Lists — contain shared information. The default lists are
Calendar and Tasks.
¢ Discussions — contain discussion boards that allow users to
post messages and comments in a chronological format.
o Recycle Bin — contains deleted information.
o All Site Content — contains a list of everything on the current
site.
Note: As additional content is added to the site, by you or an
Administrator, additional shortcuts will also appear on the Quick
Launch bar.

Using the Ribbon (New!
The ribbon brings the productivity offered in Office to the
SharePoint environment, It contains command buttons grouped

" by task that allow you to quickly and efficiently work within the

site. The ribbon appears when you click on a tab on the Tab bar
and in some pop-up windows. For example, when you create a new
event in the Calendar, the Edit ribbon appears in the New Item
window.

Tab Command Button
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Deleting an Item

1. Place your mouse pointer over the item you want to delete.
2. Click the Edit || arrow.

3. Select Delete or Delete Item from the resulting menu.

4. Click the OK button to confirm deletion.

Permanently Deleting an Item

1. Click the Recycle Bin shortcut on the Quick Launch bar.
2, Check the box next to the item you want to delete.

3. Click the Delete Selection shortcut.

4. Click the OK button.

Restoring a Deleted Item

Ttems in the Recycle Bin will be permanently deleted after 30 days.

1. Click the Recycle Bin shortcut on the Quick Launch bar.

2. Check the box next to the item you want to restore.

8. Click the Restore Selection shortcut.

4. Click the OK button to confirm that you want to restore the
item.

Note: Items will be restored fo their original location.

Searching a SharePoint Site

1. Open the site you want to search.

2. Enter what you want to search for in the Search this site box.
3. Click the Search £ button.

Note: Your results will be displayed in the search results page.



Documents

Opening and Editing a Document

1. Click the Shared Documents shortcut on the Quick Launch
bar.

2. Click the name of the Office document you want to open.

3. In the dialog box that appears, do one of the following:
¢ To edit the document, select Edit.
¢ To open the document, select Read Only.

4. Click the OK button. (You may be asked to enter your
password to open the file.)

5. Optional: Make desired changes to the document.

6. When you are finished, click the Save |id| button on the Quick
Access toolbar.

7. Click the Close [B&38 button to close the document.

Note: To quickly edit a document place your mouse pointer over

the document you want to edit. Click the Edit {g| arrow and select

Edit in “Program Name” from the resulting menu.

Creating a New Document

By default, new documents created in a document library are Word

documents.

1. Click the Shared Documents shortcut on the Quick Launch
bar.

2. Click on the Documents tab on the Tab bar.

3. Optional: Click the folder name of the folder you want to
create the document in.

4. Click the New Folder button in the New group.

5. Click the OK button.

6. Enter and format information in the Word document.

7. When you are finished, click the Save || button on the Quick
Access toolbar.

8. Enter a name for the file in the File name box.

9. Click the Save button.

10. Click the Close button to close the Word document.

Creating a New Folder
1. Click the Documents shortcut
on the Quick Launch bar.

2. Click on the Documents tab
on the Tab bar.

3. Click the New Folder button
in the New group. ;

4. Enter a name for the folder in the Name box.

5. Click the Save button.

Uploading a Document

1. Click the Shared Documents shortcut on the Quick Launch
bar.

2, Click on the Documents tab on the Tab bar.

3. Click the arrow on the Upload Document button in the New
group.

4. Do one of the following:

e To upload one document, select Upload Document from the
resulting menu. Click the Browse button, locate and select
the document you want to upload, and click the Open button.
Click the OK button. .

e To upload multiple documents, select Upload Multiple
Documents. Select the location that contains the documents
you want to upload. Check the box next to the document
name for each document you want to upload. Continue until
you have checked all of the documents you want to upload.
Click the OK button.

Note: To quickly upload one document, click the Add document
shortcut at the bottom of the file list.

Checking Out a Document

If you want to be the only user that can

make changes to a document, you need to

check the document out.

1. Click the Shared Documents shortcut on
the Quick Launch bar.

2, Click on the Documents tab on the Tab bar.

3. Select the document you want to check out.

4. Click the Check Out button in the Open & Check Out group.

5. Click the OK button. (A check out icon & will appear next to
the document to show that it is checked out.)

Checking In a Document

1. Click the Shared Documents shortcut on the Quick Launch
bar. .

2, Click on the Documents tab on the Tab bar.

3. Select the document you want to check in.

4. Click the Check In button in the Open & Check Out group.

5. Select Yes or No in the Retain your check out after checking
in? section.

6. Optional: Enter comments in the Comments box.

7. Click the OK button.

Note: To check in a file and discard any changes that were made,

select the document you want to check in. Click the Discard Check

Out button in the Open & Check Out group.

Viewing Document Properties

1. Click the Shared Documents shortcut on the Quick Launch
bar.

2. Click on the Documents tab on the Tab bar.

3. Select the document you want to view properties for.

4. Click the View Properties button in the Manage group.

5. Optional: Make selections in the Manage and Actions groups.

6. Click the Close button when you are finished.

Editing Document Properties
1. Click the Shared Documents shortcut on the Quick Launch
bar.

* 2. Click on the Documents tab on the Tab bar.

3. Select the document you want to edit properties for.
4. Click the Edit Properties button in the Manage group.
5. Enter new information in the Name and Title boxes.
6. Click the Save button.

Downloading a Document to Your Computer

You can download a current copy of a file to your computer. Note

that it will not remain synced to the original file on the server.

1. Click the Shared Documents shortcut on the Quick Launch
bar.

2, Click on the Documents tab on the Tab bar.

3. Select the document you want to download.

4, Click the Download a Copy button in the Copies group.

5. Click the Save button.

6. Select a location to save the file.

7. Click the Save button.

E-mailing a Link to a Document

1. Click the Shared Documents shortcut on the Quick Launch
bar.

2. Click on the Documents tab on the Tab bar.

3. Select the document you want to e-mail a link to.

4. Click the E-mail a Link button in the Share & Track group.

5. Enter recipient information in the To box.

6. Enter a subject in the Subject box.

7. Click the Send button when you are finished.




Lists

Creating an Event

1. Click the Calendar shortcut on the Quick Launch bar.

2. Click on the Events tab.

8. Click the top part of the New Event button in the New group.

4. Enter a title for the event in the Title box.

5. Optional: Enter a location for the event in the Location box.

6. Enter or select a start date and time in the Start Time boxes.

7. Enter or select an end date and time in the End Time boxes.

8. Optional: Enter a description for the event in the Description
box.

9. Optional: Enter or select a category in the Category section.

10. Optional: Check the Make this an all-day activity that doesn’t
start or end at a specific hour box.

11. Opfional: Check the Make this a repeating event box and select
repeat options.

12. Optional: Check the Use a Meeting Workspace to organize
attendees, agendas, documents, minutes, and other details for
this event box. Make selections and enter information in the
New Meeting Workspace page and click the OK button.

13. Click the Save button when you are finished.

Nofe: To quickly create an event, place your mouse pointer over

the day or time that you want the event to take place and click

the Add shortcut.

Editing an Event

1. Click the Calendar shortcut on the Quick Launch bar.
2. Click on the Events tab.

3. Select the event you want to edit.

4. Click the Edit Event button in the Manage group.

5. Make changes to the event.

6. Click the Save button.
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Changmg the Calendar View b ter
. Click the Calendar shortcut on the Quick ':,r ':: ;:;
Launch bar. Ot Mov  Dec

2. Click on the Calendar tab.

3. Click the Day, Week, or Month button in
the Scope group.

4. Optional: To go to today’s date in the
calendar, click the Today is link in the
Quick Launch bar. ;

Note: You can also click the shortcuts in the Quick Launch bar to

navigate through the calendar.

Today is Thursday, June 03,
2010

8 Calendarf i View
Calendsr ]

Creating a Task

Click the Tasks shortcut on the Quick Launch bar.

Click on the Items tab.

Click the top part of the New Item button in the New group.
Enter a title for the task in the Title box.

Optional: To select a task that needs to be finished before

the new task, select a task in the left pane and click the Add
button.

Optional: Click the arrow on the Priority box and select a
priority from the resulting menu.

Optional: Click the arrow on the Status box and select a status
from the resulting menu.

8. Optional: Enter a number value in the % Complete box.

9. Optional: Enter a user name or names in the Assigned To box.
10. Opfional: Enter a description of the task in the Description box.
11. Optional: Enter a start date in the Start Date box.

12, Optional: Enter a due date in the Due Date box.

13. Click the OK button when you are finished.

G g 0o

N e

Creating an Announcement

1. Click the Lists shortcut on the Quick
Launch bar.

2. Click the Announcements shortcut.

3. Click on the Items tab.

4. Click the top part of the New Item button in the
New group.

5. Enter a title for the announcement in the Title box.

6. Optional: Enter text for the announcement in the Body box.

7. Optional: Enter an expiration date in the Expires box.

8. Click the Save button when you are finished.

Addmg a Link
. Click the Lists shortcut on the Quick Launch bar.

2. Click the Links shortcut.

3. Click on the Items tab.

4. Click the top part of the New Item button in the New group.

5. Enter a URL for the Web site you want to link to in the Type
the Web address box. (70 check if the link worlfs, click the Click
here to test shortcut and click the Close e button when
you are finished.)

6. Optional: Enter a description for the link in the Type the
description box.

7. Optional: Enter notes for the link in the Notes box.

8. Click the Save button when you are finished.

Editing a List Item

The following steps show how to edit all list items except for
events.

1. Click the Lists shortcut on the Quick Launch bar.

2. Select the list that contains the item you want to edit.

3. Place your mouse pointer over the item you want to edit.
4. Click the Edit g| arrow.

5. Select Edit Item from the resulting menu.

6. Make changes to the item.

7. Click the Save button.

. Adding an Attachment to a List Item

1. Create the list item you want to add an attachment to.
2, Click the Attach File button in the Actions group.

3. Click the Browse button.

4. Locate and select the file you want to add.

5. Click the Save button and click the OK button.

Discussions

Creating a New Discussion Thread

1. Click the Discussions shortcut on the Quick Launch bar.

2. Select the discussion board you want to create the discussion in.
3. Click on the Items tab.

4. Click the top part of the New Item button in the New group.

5. Enter a subject for the discussion in the Subject box.

6. Enter and format discussion text in the Body box.

7. Click the Save button when you are finished.

Note: To quickly create a new discussion thread, click the Add
new discussion shortcut.

Reading and Replying to a Discussion Thread
1. Click the Discussions shortcut on the Quick Launch bar.

2. Select the discussion board you want to read.

3. Click the thread name to read the discussion text.

4. Click the Reply shortcut.

5. Enter reply text in the Body box.
6. Click the OK button when you are finished.




Pages

There are several different types of pages within the SharePoint

site.

o System Pages — are site pages that are not editable. These
include All Site Content, Recycle Bin, and Site Settings.

o Web Part Pages — are site pages that contain many types of
data. They are editable, but they are a little more difficult to
change.

o Wiki Pages — are site pages that are easily editable. This is the
default page format in SharePoint Server 2010. You can tell
that a page is a Wiki page if the Edit button is displayed
on the Tab bar.

Creating a New Page

1. Click the Site Actions button.

2. Select New Page from the
resulting menu.

3. Enter a name for the page in the
New page name box.

4. Click the Create button. (By
default, a Wiki page is created.)

Note: You can also click the Site Pages shorfcut on z‘he Quwk

Launch bar and click the Add new page shortcut.

Deleting a Page

1. Click the Site Pages shortcut on the Quick Launch bar.
2. Click the name of the page you want to delete.

3. Click on the Page tab.

4. Click the Delete Page button in the Manage group.

5. Click the OK button to confirm deletion.

Note: There are some pages that you cannot delete.

Renaming a Page

1. Click the Site Pages shortcut on the Quick Launch bar.
2. Click the name of the page you want to rename.

3. Click the Edit 28 button on the Tab bar.

4. Click on the Page tab.

5. Click the Rename Page button in the Manage group.

6. Enter the new name in the New Page Name box.

7. Click the Save now button.

Note: There are some pages that you cannot rename.

Inserting Text on a Page

1. Click the Site Pages shortcut on the Quick Launch bar.
2. Click the name of the page you want to add text to.

3. Click the Edit I8l button on the Tab bar.

4. Click on the Format Text tab.

5. Do any of the following:

e To insert text, click in a text box and enter text.

e To format text, select the text you want to format and make
selections in the Font and Paragraph groups.

e To apply a style to text, select the text you want to format.
Click the Styles button in the Styles group and select a style
from the resulting menu.

e To apply a pre-formatted layout, click the Text Layout
button in the Layout group and select a layout style from the
resulting menu.

e To format text using HTML, make selections in the Markup
group.

6. Click the Save & Close B button on the Tab bar when you
are finished.

Addmg a List to a Page
. Click the Site Pages shortcut on the
Quick Launch bar.

2. Click the name of the page you want to
add text to.

3. Click the Edit button on the Tab bar.

4. Click on the Insert tab.

5. Click in the page where you want to add the list or library.

6. Select the list you want to add in the Web Parts box.

7. Click the Add button.

8. Optional: Repeat steps 5-7 to add additional web parts.

9. Click the Save & Close button on the Tab bar when you
are finished.

Web Parts

Addmg a Web Part
. Open the page you want to add a web part to.
2. Click the Site Actions button.
3. Select Edit Page from the resulting menu.
4. Click on the Insert tab.
5. Click the Web Part button in the Web Parts group.
6. Select the web part you want to add in the Web Parts box.

7. Click the Add button.

8. Optional: Repeat steps 5-7 to add additional web parts.
9. Click the Save & Close button on the Tab bar when you
are finished.

Removmg a Web Part
. Open the page you want to delete a web part from.

2 Click the Site Actions button.

3. Select Edit Page from the resulting menu.

4. Select the web part you want to delete.

5. Click on the Options tab.

6. Click the Delete button in the State group.

7. Click the OK button to confirm deletion.

8. Click the Save & Close button on the Tab bar when you
are finished.

Minimizing a Web Part

1. Open the page that contains the web part you want to minimize.

2, Click the Site Actions button.

3. Select Edit Page from the resulting menu.

4. Select the web part you want to minimize.

5. Click on the Options tab.

6. Click the Minimize button in the State group.

7. Click the Save & Close K&l button on the Tab bar when you
are finished.

Note: You can also minimize a web part on the page itself. Click

the Edit Q arrow on the web part you want to minimize and

select Minimize from_the resulting menu. To restore the Web

part, click the Edit {g] arrow and select Restore from the resulting

menu.

Moving a Web Part

1. Open the page that contains the web part you want to move.
2, Click the Site Actions button.

3. Select Edit Page from the resulting menu.

4. Select the web part you want to move.

5. Click on the Format Text tab.

6. Click the Cut button in the Clipboard group.

7. Click in the page where you want to move the web part.

8. Click the Paste button in the Clipboard group.




Blogs

Creating a New Blog Post

1. Click the shortcut to the blog site on the Link bar.

2. Click the Create a post
shortcut in the Blog
Tools section.

3. Enter a title for the
post in the Title box.

4, Optional Enter post
text in the Body box.

5. Optional: Click the arrow on the Category box and select a
category from the resulting menu.

6. Enter or select a date and time in the Published section.

7. Click the Publish button.

Note: You can also click the Manage posts shortcut in the Blog

Tools section and click the Add new item shortcut.
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Commenting on a Blog Post

1. Click the name of the post you want to comment on.

2, Click the Comments link at the bottom of the post.

3. Optional: Enter a title in the Title box.

4. Enter comment text in the Body box.

5. Click the Submit Comment button.

Note: You can also create a link to the post or e-mail a link of the
post.

Deleting a Blog Post

1. Click the Manage posts shortcut in the Blog Tools section.
2. Check the box next to the post you want to delete.

3. Click the Delete Item button in the Manage group.

4. Click the OK button to confirm deletion.

Editing a Blog Post

1. Click the Manage posts shortcut in the Blog Tools section.
2. Select the blog post you want to edit.

3. Click the Edit button next to the blog post title.

4. Make changes to the post.

5. Click the Publish button when you are finished.

Pictures

Uploading a Picture to a Library

1. Click the Pictures shortcut on the Quick Launch bar.
2. Select the library you want to add a picture to.

8. Click the Upload uriead - button.

4. Click the Browse button.

5. Locate and select the picture file you want to add.

6. Click the Open button.

7. Optional: Check or clear the Overwrite existing files box.
8. Click the OK button when you are finished.

9. Enter or change picture properties.

10. Click the Save button.

Deleting a Picture

1. Click the Pictures shortcut on the Quick Launch bar.

2. Select the library that contains the picture you want to delete.
3. Check the box next to the name of the picture you want to
delete.

Click the Actions Actions - button.

Select Delete from the resulting menu.

Click the OK button to confirm deletion.
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Viewing a Slide Show

1. Click the Pictures shortcut on the
Quick Launch bar.

2. Select the library that you want to view a
slide show of.

3. Click the Actions Actions- ' button.

4. Select View Slide Show from the resulting menu.

5. Click the Play [? | button.

6. Optional: To stop the slide show, click the Stop IE] button.
(The slide show will end automatically after all the pictures
have been displayed.) Sl

7. When the slide show is finished, click the Close [
to close the Slide Show window.

Note: To scroll through the pictures in a library at your own pace,

click the Previous lﬁ and Next vy | buttons.

Extras

Creating an Alert for an Item
1. Open the library or list that contains the item that you want to
create an alert for.
2. Do one of the following:
o To create an alert for a calendar item, click the event name.
o To create an alert for another ifem, place your mouse
pointer over the item. Click the Edit Q arrow and select View
Item from the resulting menu.
3. Click the Alert Me button in the Actions group.
. Select options for the alert or leave default options.
5 Click the OK button when you are finished.
Note: To edit all alerts, click the Site Settings button on the Tab
bar, select My Settings from the resulting menu, and click the My
Alerts shorfcut.

Changing Site Settings

If you have proper permissions, you can change the look and feel
of the site in the Site Settings section.

1. Click the Site Actions button on the Tab bar.

" 2, Select Site Settings from the resulting menu.

3. Click a setting subhead and enter or select options.
4. Click the Home button when you are finished.

Signing Out
It is especially important to sign out when you are using a public
computer.
1. Click the Site Settings button on the Tab bar.
2. Do one of the following:
e To sign out of your account, select Sign Out from the
resulting menu.
o To sign in as a different user, select Sign in as a Different
User from the resulting menu. Enter the user name and
password and click the OK button.
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Views

Changing the View Format

1. Click the Lists or Libraries shortcut on the Quick Launch bar.

2. Select the list or library that you want to change the view for.
3. Click on the List or Library tab.
4. Do one of the following in the View Format group.:
e To view your information in a list, click the Standard View
button.
e To view your information in table format similar to a
spreadsheet, click the Datasheet View button.
Note: The Calendar does not have Standard or Datasheet views.

Creating a Custom View

1. Click the Lists or Libraries shortcut on the Quick Launch bar.

2. Select the list or library that you want to create a view in.

3. Click on the List or Library tab.

4. Click the Create View button.

5. Select a view format.

6. Enter a name for the view in the View Name box.

7. Enter or select options.

8. Click the OK button when you are finished.

Note: To display a custom view, click on the List or Ltbrary tab.
Click the arrow on the Current View box and select a view from
the resulting menu.

Edltmg or Deleting a View
. Click the Lists or Libraries shortcut on the Quick Launch bar.

2. Select the list or library that you contains the view you want to

edit or delete.
3. Click on the List or Library tab.
4. Click the arrow on the Current View box and select the view
you want to edit or delete.
5. Click the Modify View button.
e To edit the view, make changes to view options and click the
OK button.
o To delete the view, click the Delete button and click the OK
button.
Note: You cannot edit or delete default views.

Workmg with Datasheet View
. Click the Lists or Libraries shortcut
on the Quick Launch bar.
2. Select the list or library that you want to
display in Datasheet view.
3. Click on the List or Library tab.
4. Click the Datasheet [
View button in the
View Format group.
5. Do any of the
following in the
Datasheet group: ' .
* 7o add a new row, click the New Row button
e To display the Datasheet Task Pane, click the Show Task
Pane [ button. (Click the button again to hide the task
pane.)

* To display the totals of each column, click the Show Totals
& putton.

e To reload the page and update data, click the Refresh Data
1@/ button.

Note: You can also right click in the a row or column to add or

remove rows and columns.
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Sorting Data in a View

1. Click the Lists or Libraries shortcut on the Quick Launch bar.

2. Select the list or library that you contains the data you want to
sort.

3. Click on the List or Library tab.

4. Do one of the following:

o To sort data in Standard view, click the Standard View
button in the View Format group. Place your mouse pointer
over the column heading you want to sort and click the Edit
arrow.

e 7o sort data in Datasheet view, click the Datasheet View
button in the View Format group. Click the arrow on the
column heading.

5. Select Sort Ascending or Sort Descending from the resulting
menu.

Getting Help

Using SharePoint Server Help

1. Click the Help @ button on the Link bar. (If SharePoint

Server help is not displayed, click the arrow on the box to

the left of the Search box and select SharePoint Server

2010 from the resulting menu.)

2. In the Browse SharePoint Server 2010 Help sectlon click
_a topic to view its subtoplcs

3. Clicka subtopic to display help information.

4. Click the Close 3l button when you are finished.

Note: If you cannot find what you are looking for in the

- SharePoint Help window, click the Help and How to link to

- connect fo the Microsoft Oﬁ" ice home page.

_ Searching for a Help Topic
1. Click the Help @ button on the Link bar.
2. Enter what you want to search for in the Search box.

. 3. Click the Search button.
4. Click a link to display help information.
5. Click the Close button when you are finished.
Note: Search results include help topics, as well as links fo
Office Online training resources.

Na\ugatmg in the llelp Wmdow

1. Click the Help @ button on the Link bar.

2. In the Browse SharePoint Server 2010 Help sectlon click a

topic to view its subtopics.

3. Click a subtopic to display help information.

4. Do any of the following: o
To navigate through previously vtewed topzcs chck the Back
'@© and Forward ® buttons. ’
To return to the home page, click the Home in] button

5. Click the Close lEM button when you are finished.

Note: You can also click a link in the breadcrumb navtgatton at

the top of the Help wmdow '

Pri‘nting[a Help Topic
1. Click the Help @ button on the Link bar.

2. Display the Help topic you want to print.

8. Click the Print & button.

4. Optional: Select print options.

5. Click the Print button.

6. Click the Close [MEMM button when you are finished.
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